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Prakata

Buku ini ditulis sebagai salah satu siri MS PowerPoint yang boleh
dijadikan panduan dan tutorial dalam menghasilkan
persembahan berbentuk video animasi. Ia ditulis secara
langkah demi langkah dalam memberi kefahaman kepada
pembaca yang baru berjinak-jinak dengan penghasilan
animasi.

Buku ini akan memandu pemula animasi untuk menghasilkan
animasi menggunakan MS PowerPoint dengan
mempersembahkan cara kerja secara langkah demi langkah
yang disokong dengan grafik. Terdapat lima persembahan
animasi yang dibangunkan menggunakan lapan jenis kesan
animasi yang disediakan oleh perisian MS PowerPoint

Sebagai penulis, saya mengakui bahawa masih terdapat
kekurangan pada karya ilmiah ini. Oleh itu, kritik dan saranan
daripada seluruh pihak sentiasa diharapkan demi
kesempurnaan karya akan datang. Semoga karya ilmiah ini
membawa pemahaman dan pengetahuan bagi kita semua
tentang kepelbagaian aplikasi dalam MS PowerPoint.
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 Animasi
Animasi adalah kaedah atau proses untuk menjadikan
objek muncul sebagai gambar yang  bergerak 1

2
3
4
5

Animasi boleh dihasilkan dengan menambahkan
pergerakan kepada objek statik menggunakan pelbagai
teknik

Animasi yang dibangunkan dengan perisian komputer
memerlukan 12 hingga 15 bingkai (frame) supaya
pergerakan objek berfungsi dengan baik

Terdapat 2 teknik untuk menghasilkan animasi iaitu animasi
tradisional dan animasi berkomputer

PENGENALAN ANIMASI

Animasi merupakan salah satu elemen dalam
persembahan multimedia yang boleh menarik minat
audien untuk menonton satu-satu persembahan
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ANIMASI TRADISIONAL

ANIMASI BERKOMPUTER

Objek akan dilukis menggunakan
tangan di dalam bingkai (frame). 1
saat animasi memerlukan 20
bingkai. Oleh itu, bagi animasi
selama 2 minit, pelukis memerlukan
sekitar 2400 helaian objek.

Merujuk kepada animasi yang
dihasilkan menggunakan
teknologi komputer. Objek akan
digerakkan secara linear
merentasi skrin menggunakan
teknik tweening atau teknik
keyframing bagi menghasilkan
pergerakan.

Image oleh Pixabay 

Image oleh Pixabay 

 Teknik
Menghasilkan

Animasi
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 Kelebihan
animasi dalam
persembahan

Animasi merupakan salah satu elemen dalam multimedia
selain daripada teks, audio, video dan grafik. Penggunaan
animasi adalah pelbagai, tetapi animasi lebih dikenali 
 sebagai elemen hiburan fantasi contohnya kartun Upin
Ipin, Walt Disney, Boiboiboy dan sebagainya.    

Visual lebih
dinamik

Elemen
kreatif
menarik

minat audien

Visual mampu
menzahirkan

fantasi
manusia

Menceriakan
kandungan

persembahan
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Kategori 
Animasi

ANIMASI 2D

ANIMASI 3D

Animasi 2D adalah animasi dua dimensi yang mana ia hanya
boleh dilihat melalui pandangan hadapan. Objek animasi 2D
ialah berasaskan imej vektor. Pergerakan animasi 2D boleh
dibina menggunakan perisian yang mempunya garis masa
(timeline) di mana objek disusun secara linear dalam garis
masa dan perubahan pergerakan dibuat dalam bingkai
(frame). Contoh perisian pembangunan animasi yang popular
dalam kalangan pemula ialah Adobe Flash .

Animasi 3D adalah objek animasi
yang terdapat dalam ruang tiga
dimensi. Animasi ini tidak hanya
memiliki tinggi dan lebar, tetapi juga
memiliki elemen kedalaman (tinggi,
lebar, kedalaman). Objek animasi
boleh berpusing dan bergerak
seperti objek asal dan boleh dilihat
seolah-olah objek yang nyata dan
hidup. 

Image oleh Pixabay 

Animasi 3D dibuat kerana keinginan manusia (audien) untuk
membuat objek kelihatan hidup dan dapat bergerak
berdasarkan ekspresi daripada objek tersebut.

Image oleh Pixabay 
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contoh siri animasi 

Doraemon

2d

Looney Tunes

Lion King

Upin Ipin

Finding Nemo

3d

Toy Story

Cars

Boboiboy
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 Fungsi
Animasi dalam
Persembahan

01

Hiburan contohnya kartun
dan video permainan

Pemasaran contohnya iklan

Pembelajaran contohnya
perisian simulasi 

Kesihatan contohnya model
perubatan 3D maya

Senibina contohnya model
bangunan 3D maya

02

03

04

05
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Perisian 
Pembangun Animasi 

Pensil2D OpenToonz

Animation 
paper

01.

02.

03. 04.

Berikut merupakan aplikasi pembangunan animasi yang boleh
digunakan bagi seorang pemula untuk mendapatkan gambaran
ringkas mengenai animasi. Perisian ini boleh dipasang dalam
komputer yang beroperasi dalam persekitaran Mac OS X, Linux,
dan Windows.

STYKZ
01.

3D Aurora Blender
01. 02.

Clara.IO
04.

Anim8or
03.

 Animasi 2D

 Animasi 3D
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CIPTA ANIMASI
LANGKAH DEMI
LANGKAH
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 Pengenalan
Animasi yang ringkas boleh dibangunkan dengan
menggunakan Ms PowerPoint kerana perisian ini menyediakan
fungsi Animations dalam bar menunya. 

Fungsi Animations dalam bar menu MS PowerPoint 

Animasi ini berfungsi untuk melengkapkan kandungan dan
menarik perhatian pengguna terhadap elemen penting dalam
persembahan.  Objek yang terdapat dalam slaid persembahan
seperti teks, grafik dan bentuk boleh diberi kesan animasi supaya  
elemen pergerakan wujud pada objek tersebut. 

Namun begitu, kesan animasi tidak boleh keterlaluan sehingga 
 mengganggu kandungan utama slaid persembahan;  kecuali
persembahan ialah sepenuhnya berbentuk animasi.
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Tips
Menggunakan

Animasi

Jangan Berlebihan
Animasi yang berlebihan mengganggu audien. Tumpuan
utama haruslah isi kandungan pembentangan.1

2 Konsisten
Jika anda menggunakan animasi transisi untuk menukar
slaid, pilihan animasi transisi tersebut mestilah konsisten
untuk setiap slaid sehingga akhir persembahan.

Penekanan
Animasi boleh digunakan untuk memberi penekanan
terhadap isi utama bagi  menarik perhatian audien.
Isi utama itu mungkin boleh muncul dari bahagian
bawah, atas, kiri atau kanan slaid persembahan. 

3
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Kesesuaian
Pilih animasi yang sesuai dengan isi utama yang ingin
diberi penekanan. 
Contoh: Animasi yang sesuai bagi  memberi emosi
teruja terhadap angka yang besar dalam
membentangkan keuntungan ialah animasi Blink, bukan
Swivel yang boleh membuat penonton terganggu.

4

Kolaborasi
Animasi boleh digabungkan dengan fungsi Bullet and
Numbering supaya persembahan isi penting boleh
muncul secara satu persatu. Ini bermaksud, satu isi
kandungan dengan satu Bullet atau Numbering akan
muncul dalam slaid pembentangan dengan satu jenis
animasi, diikuti dengan isi kandungan yang lain. Ia
dibuat begitu supaya isi penting itu dapat
dipersembahkan berdasarkan kepada keutamaan.

5

Pilihan jenis animasi Blink untuk memberi
penekanan keterujaan
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Realistik
Tidak semua isi kandungan dalam slaid pembentangan
memerlukan animasi kecuali ia merupakan isi penting.
Oleh itu, pemilihan jenis animasi perlu realistik dengan
jenis isi kandungan.
Hadkan hanya dua atau tiga jenis animasi sahaja
dalam satu slaid pembentangan agar tidak
mengganggu isi kandungan.

6
Rancang
Kandungan, jenis animasi dan jenis transisi dalam slaid
pembentangan perlu dirancang. Ini kerana, animasi
dan transisi yang banyak akan membuatkan masa
persembahan slaid bertambah. Walaupun masa
Animations boleh dikawal menggunakan fungsi Timing,
ia tetap akan menyebabkan audien bosan jika
pembentangan mengambil masa yang lama.

7

 Fungsi Timing untuk mengawal masa
animasi 
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Video Animasi
dalam MS
Powerpoint 

Keupayaan MS PowerPoint menyediakan kesan animasi
terhadap peralihan visual yang lancar dalam slaid
persembahan membolehkan ia sesuai bagi membangunkan
persembahan video animasi.

Fungsi gerakan dalam animasi secara semula jadi mampu
menarik perhatian mata audien. Jika kesan animasi ini
dibangunkan dan dihasilkan dengan baik, pengalaman
mengikuti pembentangan akan menjadi menarik dan dinamik.

Idea utama menggunakan animasi bukan sekadar untuk
menjadikan kandungan tersebut interaktif dan menghiburkan,
tetapi juga untuk menarik perhatian audien kepada perkara-
perkara penting supaya persembahan lebih diingati.
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Terdapat pelbagai jenis pilihan animasi yang boleh
diaplikasikan ke dalam teks, bentuk atau grafik seperti Fly In,
Appear, Blink, Fade dan pelbagai lagi untuk menjadikan slaid
persembahan menarik. Pilihan animasi itu boleh juga
dipelbagaikan untuk menjadikan animasi yang berturutan
seterusnya menjadi satu pakej video linear. 

Kepelbagaian jenis pilihan animasi dalam
MS PowerPoint untuk membangunkan video

animasi
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Kombo animasi: pelbagai animasi diterapkan pada satu
objek
Animasi "custom motion path" : Pergerakan rekaan sendiri

Bagi mereka yang mempunyai imaginasi melampaui animasi
PowerPoint standard, persekitaran dan fungsi dalam
PowerPoint berupaya untuk menghasilkan animasi yang lebih
kompleks dan unik melalui teknik yang dinamakan animasi
khusus (custom animation). Melalui pilihan, susunan dan
tetapan yang kreatif, video animasi menggunakan perisian ini
boleh dihasilkan.

Dalam MS PowerPoint, terdapat dua teknik yang boleh
diaplikasikan dalam membangunkan video animasi melalui
animasi khusus iaitu :

1.

2.

Dengan mengaplikasi kedua-dua teknik ini pada objek di
dalam slaid berdasarkan ketetapan yang bersesuaian,
seterusnya fail persembahan disimpan dalam format video,
video animasi dapat dihasilkan dengan mudah.

CIPTA ANIMASI LANGKAH DEMI LANGKAH 17



Aplikasikan
"custom motion
path" dalam objek
pada slaid

Masukkan objek
dalam slaid pada

MS PowerPoint

Masukkan beberapa
jenis animasi (kombo
animasi) dalam satu

objek pada slaid

4

3

2

1

1

Simpan slaid
pembentangan
dalam format

video

VIDEO
ANIMASI

X
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 Mengapa MS
PowerPoint boleh

menghasilkan video
animasi?

Berikut merupakan elemen yang membolehkan  video animasi
dihasilkan menggunakan perisian ini :

Format Video
MS PowerPoint menyediakan format video iaitu MPEG-4 dan
Windows Media Video bagi penyimpanan fail.1

Format video untuk penyimpanan fail
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Fungsi garis masa (timeline) pada Animation
Pane
Panel ini berfungsi menyenaraikan objek pada slaid yang
diberikan kesan animasi. Ia boleh juga digunakan untuk
menyusun turutan kesan animasi yang akan berlaku pada
mana-mana objek dalam satu slaid persembahan. 

Animation Pane juga mempunyai fungsi garis masa
(timeline) seperti mana-mana perisian pembangunan
animasi linear yang lain untuk mengawal jangka masa
kesan animasi terhadap  objek tersebut.

2

Panel Animasi (Animation Pane) yang
berfungsi untuk membuat susunan turutan

kesan animasi dalam slaid
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Fungsi Suara (Sound)
Animasi pada objek boleh ditambah dengan suara (sound)
untuk memberi kesan yang lebih dramatik pada slaid
persembahan. Ia terletak pada menu pilihan kesan (effect
option)dalam setiap kesan animasi yang ditambah pada
objek. 

Dengan adanya fungsi suara bersama kesan animasi,
elemen multimedia yang sepatutnya ada dalam video
animasi dapat dipenuhi.

3

Panel tetapan suara yang tersedia dalam
kesan animasi
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Gabungan elemen dalam MS Powerpoinnt
untuk menghasilkan video animasi

VIDEO ANIMASI PPT

Format
penyimpanan

(video)

Fungsi garis masa
(timeline) dalam
Animation Pane

Fungsi suara
dalam tetapan

animasi

+

+

=
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PERALATAN
(TOOLS)
ANIMASI DALAM
MS POWERPOINT
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Panel Animasi
MS PowerPoint menyediakan beberapa panel tetapan untuk
pengguna membangunkan animasi dalam slaid
pembentangan. Bagi pengguna yang biasa menggunakan
MS Windows, penggunaan peralatan (tools) ini agak
mudah kerana ia mesra pengguna walaupun bagi mereka
yang baru pertama kali menggunakan aplikasi ini. 

Berikut merupakan beberapa panel tetapan yang
disediakan oleh Animations dalam MS PowerPoint :

PANEL

ANIMATIONS1

PERALATAN (TOOLS) ANIMASI DALAM MS POWERPOINT 22



Pilih objek atau teks yang pengguna ingin animasikan
Pilih panel Animations yang terletak pada menu bar
Pilih jenis animasi 

Panel Animations membolehkan pengguna untuk menambah
elemen pergerakan dalam objek yang dimasukkan ke dalam salid
MS PowerPoint. Animations ini terletak pada bar menu perisian
dan ia menyediakan pelbagai jenis pergerakan yang boleh
diaplikasikan kepada objek yang ingin diberi kesan animasi. 

Cara membuka panel Animations :
1.
2.
3.

Entrance effect
Emphasis effect
Exit effect 

*Terdapat tiga kategori animasi dalam panel ini iaitu :

EFFECT OPTIONS2

Pilih jenis animasi dalam panel Animations
Pilih kesan tambahan dalam Effect Options

Effect Options merupakan pilihan kesan animasi tambahan yang
boleh diaplikasi pada objek dalam slaid setelah jenis kesan
animasi dipilih. Ia terletak pada menu bar bersebelahan dengan
panel Animations.

Cara membuka Effect Options :
1.
2.
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ANIMATION PANE3

Animation Pane merupakan fungsi yang disediakan untuk
membuat tetapan susunan animasi ke atas objek di dalam slaid.
Animasi yang terletak paling atas dalam susunan akan berfungsi
dahulu diikuti turutan di bawahnya. Selain itu, ia juga berfungsi
seperti garis masa (timeline) untuk membuat tetapan panjang
masa animasi.

Animation Pane juga dijadikan tetapan untuk menerapkan
pelbagai animasi pada satu objek yang sama (kombo animasi).
Sebagai contoh di atas, objek matahari mempunyai dua jenis
animasi yang diterapkan iaitu Lines dan Blink.  Kombo animasi ini
boleh diaplikasikan dengan penggunaan fungsi Add Animation
untuk menambah animasi pada Animation Pane.
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Pilih objek dalam slaid yang ingin diberi pergerakan
Klik Animation Pane dalam panel Animations
Klik Add Animation dan pilih animasi untuk objek tersebut

Cara menghasilkan kombo animasi dalam satu objek :
1.
2.
3.

     *Animasi tersebut akan terpapar pada baris pertama dalam     
      Animation Pane
  4. Pilih semula objek yang sama, klik lagi Add Animation dan 
      pilih kesan animasi yang lain pula
     *Animasi kedua akan terpapar pada baris kedua dalam    
      Animation Pane

Objek matahari mempunyai dua jenis
animasi berbeza iaitu Lines dan Blink
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KAWALAN

ANIMASI5
Terdapat beberapa kaedah untuk membuat tetapan kawalan
bagi mana-mana pilihan animasi tersebut berfungsi, iaitu :
Animations Ribbon, Down List pada Animation pane dan Effect
Options Dialog.

Kawalan animasi yang biasa digunakan meliputi tetapan durasi
animasi, kesan suara animasi, bila animasi akan mula berfungsi
dan banyak lagi. Pengguna MS PowerPoint boleh meneroka pilihan
tetapan kawalan bagi mendapatkan kesan animasi yang
dikehendaki dan bersesuaian dengan konsep persembahan.

Animations Ribbon

Drop List Animation Pane Effect Options Dialog
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SELECTION PANE6
Selection Pane berfungsi untuk menguruskan sebarang objek
yang dimasukkan ke dalam slaid. Setelah memasukkan bentuk,
teks atau grafik ke dalam slaid, pengguna boleh membuka
Selection Pane untuk memberi nama objek (rename),
mengumpulkan objek (group and ungroup) seterusnya
menunjukkan atau menyembunyikan objek (hide and show).

Objek yang disenaraikan dalam panel disusun dalam susunan
visual-atas-ke-bawah. Objek yang baru dimasukkan adalah di
bahagian atas senarai.

Panel Selection Pane ini sangat penting dalam pengurusan kesan
animasi supaya kepelbagaian objek yang dimasukkan ke dalam
slaid boleh diuruskan dengan baik dan ia berfungsi mengikut apa
yang dikehendaki.

Selection Pane
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Mudahnya guna
Peralatan Animasi

(Tools)
MSPowerPoint

Antaramuka grafik

Mesra Pengguna

Pelbagai tetapan
kawalan

Perisian biasa bagi
pengguna MS Office
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Animasi adalah kesan visual untuk objek dalam persembahan
PowerPoint. Animasi memberi kesan pergerakan kepada objek
seperti teks, bentuk dan grafik di dalam slaid.

Dalam MS PowerPoint, terdapat tiga kategori kesan animasi iaitu
entrance, emphasis dan exit. Entrance akan membawa animasi
masuk ke dalam slaid, Exit menggerakkan objek keluar slaid,
manakala Emphasis akan memberi penekanan terhadap objek di
dalam slaid. Gabungan ketiga-tiga kesan animasi ini
membolehkan slaid MS PowerPoint berupaya menjadi video
animasi sekiranya format penyimpanan yang dipilih ialah format
video.

Pada bahagian ini, langkah demi langkah akan diberikan untuk
membangunkan slaid yang mempunyai kombo animasi sehingga
membentuk satu video animasi.

Perkara utama yang perlu dilakukan sebelum memindahkan idea
ke dalam perisian pembangunan animasi ialah perancangan.
Untuk menghasilkan pakej multimedia seperti video animasi ini,
penghasilan papan cerita (storyboard) adalah penting kerana ia
akan menjadi panduan dalam proses pembangunan video.
Banyak templat papan cerita boleh digunakan untuk membuat
perancangan cerita, jadi ia terpulang kepada keselesaan dan
kesesuaian pembangun video nanti.

Pengenalan
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Langkah demi langkah

proses MENGHASILKAN

 Video Animasi 

Tentukan konsep
video animasi
berdasarkan tujuan
persembahan

LANGKAH 1

LANGKAH 2

LANGKAH 3

Buat perancangan
menggunakan
papan cerita
(storyboard)

Kumpul material
seperti objek dan
kesan suaraLANGKAH 4

Susun objek di
dalam  perisian

pembangunan
animasi

LANGKAH 4

Masukkan animasi
ke atas objek

LANGKAH 5

Simpan (save)
slaid dalam
format video
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MARI CIPTA
ANIMASI 1

Matahari
timbul dan
bersinar
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Animasi 1
Matahari timbul dan bersinar

Animasi pertama yang akan kita bangunkan ialah pergerakan
matahari dari celah gunung, naik ke awan dan akan terus
bersinar. Terdapat dua jenis kesan animasi yang akan
diaplikasikan di sini iaitu : Lines dan Blink

Masukkan objek dan susun ke dalam slaid. Ada empat
objek di dalam slaid ini iaitu awan, matahari, gunung dan
rumput. 
Namakan objek di dalam slaid menggunakan fungsi
Selection Pane :

1.

2.

Langkah : Susun dan namakan objek

i. Home > Select > Selection Pane
ii. Klik kanan pada objek dalam Selection Pane dan namakan. 
   Dalam slaid ini, objek dinamakan sebagai rumput, awan,  
   gunung dan matahari

1 2
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1
2

3

Klik Animations dalam menu bar dan klik Animation Pane
untuk keluarkan panel Animation Pane
Pilih objek matahari pada slaid 
Pilih Animations > Motion Paths > Lines

1.

2.
3.

Langkah : Pilih kesan animasi

Klik Effect Options pada Ribbon Bar untuk mengawal
pergerakan animasi Lines tadi dan pilih Left (matahari
bergerak dari kanan ke kiri)
Kelihatan arah anak panah hijau (mula) bergerak ke anak
panah merah (akhir) menunjukkan pergerakan ke kiri
Pada Animation Pane telah ada satu senarai animasi Lines

1.

2.

3.

Langkah : Masukkan kesan animasi 1(Lines)

1

2
3
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Klik objek Matahari pada Selection Pane 
Klik Add Animation pada bar menu dan pilih Pulse (animasi 2)

1.
2.

Langkah : Masukkan animasi 2 (kombo)

Langkah : Kawal durasi animasi 2
Klik anak panah ke bawah (drop down menu) animasi
Matahari 2 pada Animation Pane untuk keluarkan dialog box
Tekan tab Timing > Start After Previous > Duration 0.5
seconds > OK
Kelihatan animasi 2 akan berfungsi selepas animasi 1 pada
garis masa (timeline)

1.

2.

3.

1

2

3 1

2

Animasi matahari timbul dan
bersinar berjaya dibangunkan!

4. Tekan Slide Show untuk melihat tetapan kombo animasi
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Klik animasi Matahari pada Animation Pane (anak panah
hijau dan merah bertukar menjadi bullet hijau dan merah
pada objek matahari)
Tarik bullet merah ke atas untuk menjadikan animasi terbit
matahari menggunakan animasi Lines 

1.

2.

Langkah : Kawal pergerakan animasi

Langkah : Kawal durasi animasi 1
Klik anak panah ke bawah (drop down menu) animasi
Matahari pada Animation Pane untuk keluarkan dialog box
Tekan tab Effect > Smooth start 0 sec > Smooth end 0s > OK
Tekan tab Timing > Start On Click > Duration 3 seconds > OK

1.

2.
3.

1

23
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MARI CIPTA
ANIMASI 2

Pertumbuhan
tanaman
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Animasi 2
Pertumbuhan tanaman (plant growth)

Oleh kerana dalam Animasi 1 kita telah memberi pergerakan
kepada matahari, Animasi kedua yang akan kita dibangunkan
ialah pertumbuhan tanaman. Terdapat hanya satu jenis
animasi yang akan diaplikasikan di sini iaitu : Wipe.

Masukkan 2 jenis objek (imej vektor) iaitu batang tumbuhan
dan 5 helai daun
Namakan objek di dalam slaid menggunakan fungsi Selection
Pane (batang, Daun 1, Daun 2, Daun 3, Daun 4 dan Daun 5)

1.

2.

Langkah : Susun dan namakan objek

1

2
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1

2

Klik Animations dalam menu bar dan klik Animation Pane
untuk keluarkan panel Animation Pane
Pilih objek batang pada slaid 
Pilih Animations > Entrance > Wipe

1.

2.
3.

Langkah : Pilih kesan animasi

Klik anak panah ke bawah (drop down menu) animasi
batang pada Animation Pane untuk keluarkan dialog box
Tekan tab Timing > Start After Previous > Duration 2
seconds > OK

1.

2.

Langkah : Kawal durasi animasi (Wipe)
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Pilih objek batang pada slaid yang telah diberi animasi
Wipe
Klik Animations >  Animation Painter pada Bar Ribbon
(proses salin)
Pilih objek yang ingin diaplikasi animasi yang sama iaitu
Daun 1 > tekan (proses tampal), pilih semula Animation
Painter, pilih objek kedua (proses tampal) dan seterusnya
(Daun 2, Daun 3, Daun 4 dan Daun 5)
Panel pada Animation Pane akan menunjukkan kesan
animasi pada objek batang dan Daun
Tekan Slide Show untuk melihat kesan animasi

Animasi Wipe akan diaplikasikan untuk kesemua objek yang
tinggal iaitu Daun 1, Daun 2, Daun 3, Daun 4 dan Daun 5. Oleh
itu, tetapan animasi sebelum ini boleh disalin ke dalam objek
daun menggunakan fungsi Animation Painter.

1.

2.

3.

4.

5.

Langkah : Salin kesan animasi

4
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Animasi 3
Burung berterbangan

Animasi ketiga yang akan kita dibangunkan ialah burung
berterbangan. Sebenarnya terdapat banyak jenis animasi yang
boleh diaplikasikan untuk menghasilkan kesan burung
berterbangan, tetapi di sini kita akan belajar animasi yang
paling ringkas bagi seorang pemula (beginner).Terdapat dua 
 jenis animasi yang akan diaplikasikan di sini iaitu : Custom
Path dan Fade.

Masukkan 2 jenis objek (imej vektor) iaitu badan burung
dan 2 sayap.
Namakan objek di dalam slaid menggunakan fungsi
Selection Pane (burung, sayap 1 dan sayap 2)

1.

2.

Langkah : Susun dan namakan objek
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Klik Animations dalam menu bar dan klik Animation Pane
untuk keluarkan panel Animation Pane
Pilih objek burung pada slaid 
Pilih Animations > Motion Path > Custom Path

1.

2.
3.

Langkah : Pilih kesan animasi

4. Sambil tekan pada objek burung, buat gerakan burung 
    bebas terbang di seluruh slaid > Enter

4
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Klik anak panah ke bawah (drop down menu) animasi
burung pada Animation Pane untuk keluarkan dialog box
Tekan tab Effect > Smooth start > 0 sec dan Smooth End >
0 sec > OK
Tekan tab Timing > Start After Previous > Duration 6 sec >
OK

1.

2.

3.

12

Langkah : Kawal durasi animasi (Custom Path)

3

Pilih objek sayap 1 pada slaid yang telah diberi animasi
Custom Path
Klik Animations >  Animation Painter pada Bar Ribbon
(proses salin)
Pilih objek yang ingin diaplikasi animasi yang sama iaitu
sayap 1 > tekan (proses tampal), pilih semula Animation
Painter dan pilih objek kedua sayap 2 (proses tampal) 

Animasi Custom Path akan diaplikasikan untuk kedua-dua
objek iaitu sayap 1 dan sayap 2. Oleh itu, tetapan animasi
sebelum ini boleh disalin ke dalam objek sayap menggunakan
fungsi Animation Painter.

1.

2.

3.

     * Ubah pada tab Timing > Start With Previous supaya 
       pergerakan sayap bersekali dengan burung

Langkah : Salin kesan animasi
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4. Panel pada Animation Pane akan menunjukkan kesan animasi 
    pada objek burung dan sayap
5. Tekan Slide Show untuk melihat kesan animasi

Klik objek sayap 1 dan sayap 2 pada Selection Pane 
Klik Add Animation pada bar menu dan pilih Fade (animasi 2)

1.
2.

Langkah : Masukkan animasi 2 (kombo)

1
2
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Langkah : Kawal durasi animasi 2

Klik anak panah ke bawah (drop down menu) animasi sayap
1 dan syap 2 pada Animation Pane untuk keluarkan dialog
box
Tekan tab Timing > Start With Previous > Duration 1 second >
OK
Kelihatan animasi Fade akan berfungsi bersekali dengan
animasi 1 (Custom Path)  pada garis masa (timeline)

1.

2.

3.

Animasi burung berterbangan 
 berjaya dibangunkan! Anda
boleh salin dan tampal untuk
mewujudkan beberapa ekor

burung di atas slaid

4. Tekan Slide Show untuk melihat tetapan kombo animasi

3
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Animasi 4
Daun pokok bergoyang

Animasi keempat yang akan dibangunkan ialah daun pokok
bergoyang.Terdapat satu  jenis animasi sahaja yang akan
diaplikasikan di sini iaitu : Spin

Masukkan 2 jenis objek (imej vektor) iaitu batang pokok dan
3 rimbunan daun
Namakan objek di dalam slaid menggunakan fungsi
Selection Pane (batang pokok, Daun pink 1, Daun pink 2 dan
Daun pink 3)

1.

2.

Langkah : Susun dan namakan objek
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Klik Animations dalam menu bar dan klik Animation Pane
untuk keluarkan panel Animation Pane
Pilih objek Daun pink 1 pada slaid 
Pilih Animations > Spin

1.

2.
3.

Langkah : Pilih kesan animasi

Klik anak panah ke bawah (drop down menu) animasi
Daun pink pada Animation Pane untuk keluarkan dialog box
Tekan tab Effect > Amount > Custom : 10 darjah >Enter >
OK. Klik untuk aktifkan Auto - Reverse > OK
Tekan tab Timing > Start With Previous  dan Duration 2 sec
> OK

1.

2.

3.

Langkah : Kawal durasi animasi (Spin)

1

2
3
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Pilih objek Daun pink 1 pada slaid yang telah diberi animasi
Custom Path
Klik Animations >  Animation Painter pada Bar Ribbon
(proses salin)
Pilih objek yang ingin diaplikasi animasi yang sama iaitu
Daun pink 2 > tekan (proses tampal), pilih semula
Animation Painter dan pilih objek kedua Daun pink 3
(proses tampal) 

Animasi Spin akan diaplikasikan untuk kedua-dua objek lain
iaitu Daun Pink 2 dan Daun Pink 3. Oleh itu, tetapan animasi
sebelum ini boleh disalin ke dalam objek sayap menggunakan
fungsi Animation Painter.

1.

2.

3.

     * Ubah pada tab Timing > Start > With Previous supaya 
       pergerakan Daun pink 2 dan Daun pink 3 adalah serentak
  4.  Kelihatan animasi Spin akan berfungsi serentak untuk 
       ketiga-tiga objek Daun pink pada garis masa (timeline)
  5. Tekan Slide Show untuk melihat tetapan animasi

Langkah : Salin kesan animasi

1

2

3
4

Animasi daun pokok bergoyang
telah berjaya dibangunkan! 
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Animasi 5
Bunga berguguran

Animasi kelima yang akan dibangunkan ialah  bunga
berguguran. Terdapat dua  jenis animasi yang akan
diaplikasikan di sini iaitu : Spin dan Diagonal Down Right

Masukkan 1 jenis objek (imej vektor) iaitu bunga. Tetapkan
objek ini di belakang rimbunan daun. Boleh juga masukkan
beberapa objek bunga yang sama
Namakan objek di dalam slaid menggunakan fungsi
Selection Pane (Bunga 1)

1.

2.

Langkah : Susun dan namakan objek
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1

3
1

2

Klik Animations dalam menu bar dan klik Animation Pane
untuk keluarkan panel Animation Pane
Pilih objek Bunga 1 pada slaid 
Pilih Animations > More Motion Paths > Lines Curves >
Diagonal Down Right > OK

1.

2.
3.

Langkah : Pilih kesan animasi

Klik anak panah ke bawah (drop down menu) animasi
Bunga 1 pada Animation Pane untuk keluarkan dialog box
Tekan tab Effect > Smooth Start : 0 sec dan Smooth End : 0
sec > OK. 
Tekan tab Timing > Start With Previous  dan Duration 5 sec
> OK

1.

2.

3.

Langkah : Kawal durasi animasi (Motion Path)
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4. Panel pada Animation Pane akan menunjukkan kesan animasi 
    pada objek Bunga 1
5. Tekan Slide Show untuk melihat kesan animasi

Klik objek Bunga 1 pada Selection Pane 
Klik Add Animation pada bar menu dan pilih Spin (animasi 2)

1.
2.

Langkah : Masukkan animasi 2 (kombo)
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Klik anak panah ke bawah (drop down menu) animasi
Bunga 1 pada Animation Pane untuk keluarkan dialog box
Tekan tab Effect > Amount : 360 degree Clockwise, Smooth
Start : 0 sec dan Smooth End : 0 sec > OK. 
Tekan tab Timing > Start With Previous  dan Duration 5 sec
> OK

1.

2.

3.

Langkah : Kawal durasi animasi (Spin)

4. Gunakan fungsi Animation Painter untuk menyalin kesan 
    animasi kepada beberapa objek Bunga yang lain.
5. Panel pada Animation Pane akan menunjukkan kesan animasi 
    pada objek Bunga yang dimasukkan
6. Tekan Slide Show untuk melihat kesan animasi

5
6

Animasi bunga berguguran
telah berjaya dibangunkan! 
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Matahari timbul
dan bersinar

5 ANIMASI 
YANG TELAH DICIPTA 

Pertumbuhan
tanaman

Burung
berterbangan

Daun pokok
bergoyang

Bunga
berguguran
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KESAN
ANIMASI MS

POWERPOINT
YANG

DIGUNAKAN

Lines dan Blink

Custom Path dan Fade

Wipe
Spin dan Diagonal

Down Right

Spin
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Eksport Video 

format PowerPoint Presentation (*.ppt) untuk
membolehkan slaid diedit semula

Bagi melengkapkan slaid menjadi video animasi, elemen audio
boleh dimasukkan ke dalam objek yang bersesuaian agar
elemen penceritaan dalam slaid persembahan lengkap
sebelum disimpan dalam format video. 
Setelah itu, animasi yang telah dibangunkan boleh disimpan
dalam 2 format iaitu :

1.

2. Format MPEG-4 Video untuk membolehkan slaid dimainkan   
   dalam bentuk video. 
   * Sila berhati-hati kerana selepas format ini dipilih, slaid 
     persembahan tidak boleh diedit lagi

Selamat beranimasi!
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1.

   2. Add animation to slides  - Microsoft Support
       https://support.microsoft.com
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